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Before Slicer3

# Slicer opt !E

File Wiew Help Modules

Data

Add Add
Volume Model
Add Transform|  Add Msmxl

MRML File Contents [Current Scene}:

[ e T e el TR s sl iy
_or| Axial | == Mone | = ssgital | Ba| Hone | _or| Gorenal | Bg | None |
We o] Mone Far| None | None Foo| None 1

iscration. ..

Slicer

TOSOIITg TIOTTT FOICeISMUSEICREaasr. . .
Loading Module wtkSubVolume. ..

Loading Module wvtkTeem.. I

Leoading Module vtkIenscorUtil...

Loading Module wvtkIransformVolume... .
Loading Mcocdule vtkVeolumeTextureMapping. ..

Launching Slicer opt...

Warning: updating year in copyright text tc 2008 from 2007

MainBoot: Reading Options.xml
Ready
{slicer
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3DSlicer

Programming into Slicer2

f Slicer 2.7-opt
Fie View Help Modules

m EMAtlssBrainClassifier a

1. 5elect Input Channels:

A None I
2 Mone I

Align T2te T1?  On I Off

2. Define Parameter Settings:

Generate 30 Models: | O _Off |
Working Directory: Ic:."s“ﬂalz.?fS“EElz._nJ
‘Save Segmentation: I? Off |

Start Segmentation

#

# 1. Step

.

#

set f $fSeg.fStep1
DevAddLabel $f.ITitle "1. Select Input Channels: " WTA
pack $f.ITitle -side top -padx $Gui(pad) -pady 1 -anchor w
frame $f.finput -bg $Gui(activeWorkspace)
pack $f.finput -side top -padx 0 -pady 0 -anchor w
foreach frame "Left Right" {
frame $f.finput.f$frame -bg $Gui(activeWorkspace)
pack $f.finput.f$frame -side left -padx 0 -pady $Gui(pad) }
foreach LABEL "T1 T2" Input "SPGR T2W" {
DevAddLabel $f finput.fLeft.I$Input " ${LABEL}:"
pack $f.finput.fLeft.I$Input -side top -padx $Gui(pad) -pady 1 -anchor w
set menubutton  $f.finput.fRight.m${Input}Select
set menu $f.finput.fRight.m${Input}Select.m

eval {menubutton $menubutton -text [Volume($EMAtlasBrainClassifier(Volume,${Input}),node) GetName]
relief raised -bd 2 -width 9 -menu $menu} $Gui(WMBA)

eval {menu $menu} $Gui(WMA)
TooltipAdd $menubutton "Select Volume defining ${Input}"
set EMAtlasBrainClassifier(mbSeg-${Input}Select) $menubutton
set EMAtlasBrainClassifier(mSeg-${Input}Select) $menu
# Have to update at UpdateMRML too
DevUpdateNodeSelectButton Volume EMAtlasBrainClassifier Seg-${Input}Select Volume,$Input
pack $menubutton -side top -padx $Gui(pad) -pady 1 -anchor w }
frame $f.fAlign -bg $Gui(activeWorkspace)
TooltipAdd $f.fAlign "If the input T1 and T2 are not aligned with each other set flag here"
pack $f.fAlign -side top -padx 0 -pady 2 -padx $Gui(pad) -anchor w
DevAddLabel $f.fAlign.IAlign "Align T2 to T1? "
pack $f.fAlign.IAlign -side left -padx $Gui(pad) -pady 1 -anchor w
foreach value "1 0" text "On Off" width "4 4" {
eval {radiobutton $f.fAlign.r$value -width $width -indicatoron O\

-text "$text" -value "$value" -variable EMAtlasBrainClassifier(Aligninput) } $Gui(WCA)
pack $f.fAlign.r$value -side left -padx 0 -pady 0 }
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| 3DSlicer Version 3.6 RC3

Yala)
File Edit View Window Help Feedback

g e - DB B

@ 3DSlicer

* Welcom: & Abot

ey *OSlicer Welcome

D Sliceris afree latiorm for medical
and 30 visualization of image data. This madule cortains some basicinformaton
and useful links tc get you started using Slicer. Please see o.rwebsite
g and the documentation on our wiki for more infornation.
3

0 SLicer is diskibuted under a BSD-style license; for deta ks aboutthe

contribution and software icense agreemert, please see
‘ofcaibiniicense/SlicerlicenseFom pl The softwa'e has been

designedor research purposes orly and has not been reviewed or approved by
tre Food and Drug Admiistration, or by any other agency.

Hint: to open any informaion panel below, click onifs grey ttle bar.

Don'tshow this module an startup.

 oveview

¥ Basic &Extended Modules

* Manipulate Slice Views

@O0

* Manipulate 30 Viw

SpgrAndr RAS: 11595, 169.5 -1.9). By: Slice notshown,
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= The New Execution Model

File

Edit  Wiew Window Help Feedback

[l [B]| s | rmiweren ][] (7] (%) [ [

N
@ 3DSlicer
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Help & Acknowledgement

-

-

Python HelloPythaon

4

-

Input'Cutput

FParameter set =
—_ =

Status Completed with errors

Input Wolume —_— ;ll
output Wolume |
. :I

-

Hello Python Farameters

Dimensionality [3 ﬂ|

-

Cefault Zarcel | | Apply |

Manipulate Slice Views

(=] & 3] [ EE @ e [EJ]

-

Manipulats 30 Wiew

- | BEEE
K

?xml version="1.0" encoding="utf-8"?>

executable>

<category> Demonstration </category>

<title> Python HelloPython </title>

<description> Slicer Developer Course </description>
<version> 1.0 </version>

<documentation-url> </documentation-url>
<license></license>

<contributor>

Sonia Pujol, Ph.D., Surgical Planning Laboratory, Harvard Medical School
/contributor>

<acknowledgements> National Alliance for Medical Image Computing (NAMIC), Grant
54 EB005149. </acknowledgements>

<parameters>

<label>Input/Output</label>

<description>Input/output parameters</description>

<image>
<name>helloPython</name>
<label>Input Volume</label>
<channel>input</channel>
<index>0</index>
<default>None</default>
<description>Input volume</description>

</image>

<image>
<name>helloPythonOutputVolume</name>
<label>Output Volume</label>
<channel>output</channel>
<index>1</index>
<default>None</default>
<description>Output filtered</description>

</image>

</parameters>

</executable>
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&2 - 3ps)icer

Slicer3 Execution Model

* This course is based on the Execution Model which
provides a mechanism for incorporating command
line programs as Slicer modules.

* Jim Miller, Dan Blezek, Bill Lorensen (GE)

* This course uses the Python interpreter that has
been integrated to Slicer.

@ python

© 2010, ARR
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Pre-requisite

* This course supposes that you have taken the following
tutorial:

Slicer3 Data Loading and Visualization, Sonia Pujol Ph.D.

* The tutorial is available on the Slicer3.6 101 compendium:

© 2010, ARR
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http://www.slicer.org/slicerWiki/index.php/Slicer3.4:Training

Material

This course requires the following material

* Slicer3-3.6.1 release version

* HelloPython.zip

Disclaimer
It is the responsibility of the user of 3DSlicer to comply with both the terms of the license
and with the applicable laws, regulations and rules.

© 2010, ARR
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“ HelloPython Course Material

Unzip the HelloPython.zip archive

spgr.nhdr

spgr.raw.gz
(124 SPGR images

2 lelloPythonsiy [-/Deskion/HelloPython) - gedit —mX
File Edit View Search Tools Documents Help
L EB.Bla|% e Z}
New Open Save | Print... | Undo Redo | Cut Copy Paste ' Find Replace
[7] HelloPython.py 3 ‘
#1/usr/bin/env python =]
XML = """<?xml version="1.0" encoding="utf-8"7>
<executable>

< cense>

<contributor> This module was developed by Sonia Pujol, Ph.D., Harvard University. </contributor>

<documentation-url> http://www.slicer.org/sliceriiki/index.php/Slicer3.6:Training </documentation-url>

<acknowledgements

This work is part of the National Alliance for Medical Image Computing (NA-MIC), funded by the National
Institutes of Health through the NIH Roadmap for Medical Research, Grant U54 EBBB5149. </acknowledgements> L
t/0utput</label>
<description>Input/output parameters</
name>hel loPythonInputVolumes</name>
<label>Input Volume</label>
=]
[ Ln 72, col 15 [ 1ns

HelloPython.py

© 2010, ARR
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Overview

* Part A: Integration of the HelloPython.py
program into Slicer3

* Part B: Implementation of the Laplace operator
in the HelloPython module

* Part C: Image Sharpening using the Laplace
operator

© 2010, ARR
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3DSlicer

ICETr

File Edit View Search Tools Documents

I'V [
Cut Copy Paste = Find Replace

0 B @[@»o

v = I
New Open  Save | Print... | Undo Redo

[ HelloPython.py % |

[#1/usr/bin/env python

XML = “*“<?xml version="1.0" encoding="utf-8"?>
<executable>

<category>Demonstration </category>
<title>Python HelloPython</title>

<description> Slicer developer course in Python
</description>

<version=1.0</version>

<license></license>
<contributor> This module was developed by Sonia Pujol, Ph.D., Harvard University. </contributor>
<documentation-url> http://www.slicer.org/sliceriliki/index.php/Slicer3.6:Training </documentation-url>
<acknowledgements>

This work is part of the National Alliance for Medical Image Computing (NA-MIC), funded by the National
Institutes of Health through the NIH Roadmap for Medical Research, Grant US4 EB085149. </acknowledgements>

<parameters>
<label>Input/Output</label>
<description>Input/output parameters</description=
<image>
<name>helloPythonInputVolume</name>
<label>Input Volume</label>
<channel>input</channel>
<index>0</index>
<description>input volume</description>
</image>
<image>
<name>hel10PythonOutputVolunes/name>
<label>output Volume</label>
<channel>output</channel>
<index>1</index>
<description>output volume</description>
</image>

</parameters>
[t 72, cor 15

[ s

Part A:

Integrating HelloPython
into Slicer3

© 2010, ARR
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Python Console

- 30 Slicer Version 3.6 RC3 — o X

Fils  Edit Feadback

e [J[]

:@ IDSlicer

| |
Select Window-> Python Interactor

"**“to launch the Python console of Slicer

- alcome & Aboul

vill

3D Slicer iz a fres opsn zource softwars platiorm for medical image proceszing and 300
visualization of imags dats. This moduls contgins some bazic information and usaful links
1o get you stared using Slicer. Pleass see our website htipiifaenw.zlicer.org and the
documentation on our wiki for more information:

hfio:ffaeeese slicer oralelicarlikifinde:. oh o Docu mentation-2.6.

3D Slicer is disribuked undsr a BSD-styls licenss; for details about the contribution and
software licenzs agreament, plegss aee

htipeffeeane.licer.orgfcg i-binfLicensad Slicarl icenssForm.pl . The softeears ha: bean designed
for reesarch purpoess only and has nol bean reviewesd or approved by the Food and Drug

Adminiziration. or by anv cther agency.

Hint: o open any information panel below, click on it grey tills bar.

Don' ehowe thiz modula on sarup.

“* Manipulak Slice Wiews

El

“ Manipulak 30 View

Maone RAS: (87.3, 1.0, -125.0),
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Python Console

Python Console v14

3D slicer Version 3.6

-
—0Ox

Python 2. 6.4+ (releaseZ6-maint:TEE51, Jun 4 2010, 11:39:23)
[GGC 3.4.6 20060404 (Red Hat 3.4.6-10)]

Copyright (c) Z2001-2009 Python Software Foundation.
Al]l Rights Reserwved.

Copyright (c) 2000 BelOpen. com.
A1l Rights Reserwved.

Copyright (c) 1995-2001 Gorporaticon for Mational Research Initiatiwes.
41] Rights Reserwved.

Copyright (c) 1991-1995 Stichting Mathematisch Centrum,
41l Rights Reserwved.

Python Console wl. 4 by Ka-Ping Tee <ping@lfw. org:
EES

Amsterdam.

e [ ] [7] = (@) | [S] [C] | - ¥ - [

Slicer’'s Python console

Active Volume:

¥ Display

£

¥ Info

“ Manipulae Slice Wiews

[=:] ft [ @]

“ Manipulake 30 View

e | [EHE
| (@ [ [@] [
L =]

Pyihon Imeracior

Mons Mone

Mons

Mone

Haons Haons
(DI [+] [DI[+]

0 o
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Python Console
e e OE|ECE File2> Add Volume

toosas | st [ [P ][ = R (] 1] (2] (D] [ [ (2 () B () (O] (O] k| S F 7

3

IDSlicer

- alcome & Aboul

3pslicer Welcome

3D Slicer iz a fres opsn zource softwars platiorm for medical image proceszing and 300
visualization of imags dats. This moduls contgins some bazic information and usaful links
1o get you stared using Slicer. Pleass see our website htipiifaenw.zlicer.org and the
documentation on our wiki for more information:

hfio:ffaeeese slicer oralelicarlikifinde:. oh o Docu mentation-2.6.

3D Slicer is disribuked undsr a BSD-styls licenss; for details about the contribution and
software licenzs agreament, plegss aee

htipeffeeane.licer.orgfcg i-binfLicensad Slicarl icenssForm.pl . The softeears ha: bean designed
for reesarch purpoess only and has nol bean reviewesd or approved by the Food and Drug

Adminiziration. or by anv cther agency.

Hint: o open any information panel below, click on it grey tills bar.

Don' ehowe thiz modula on sarup.

“* Manipulak Slice Wiews

El

“ Manipulak 30 View

Maone RAS: (87.3, 1.0, -125.0),
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3DSlicer

Python Console

File Edit ‘iew Window Help

Fython HakFrtn

¥ Help & Acknowledgement

“ Python HelloPython

* Inputiutput J

* Hello Python Parameters J

Default q

Feedback

[IHE

1% 00 me
) sw
) sw2
) swb4
) System
) tmp
) User Guides And Information
B8 [ Users
) Shared
B 3 startwallace
autobahn
.CUps
fontconfig
subversion
.Trash
) -Xcode
B () Desktop

T W A

1 ) 3MinuteFor3.6

“* Manipulate Slice Views

B @ L EE

“* Manipulate 30 View

Add Volume...

|
Recent Volumes:

) ChangeTrackerStuff-3.6

=saHelloPython/

j HelloPyth

HelloPytho

pyc

spgr.nhdr
spgr.raw.gz

3 HelloPvthon

3 KB
3 KB

5,517 KB

Sun Jun 619:

Sun Jun 611

Sun Jun 610
Sun Jun 610:

R e

=

Path: |/Usersistuartwallace/Desktop/HelloPythonispgr.nhdr

Valume Options

Gentered

Browse to CWD

Ignore File Orientation

Label Map

Single File

5 o

I~ S

Doscrptin—vao [}

| et

Name: |spar

Apply| | Cance'
P

Load the dataset spgr.nhdr
located in the directory
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g 3DSlicer
e

A AMA

File Edit Wiew Window Help Feedback

Medios: | Fyn HakEyion E
r‘\ 3DSlicer
>

T Help & Acknowledgement

Status Completed with errors

Input Volume

“* Hello Python Parameters

Default Apply

from Slicer import slicer

Python Console

N\ 3D Slicer Version 3.6 RC3

e [ (2] [A) (0] (@] el 1) [ ] [ (] & §- [
' N A

Run the following code in the
Python console

volume1 = slicer MRMLScene.GetNodeByID(“vtkMRMLScalarVolumeNode1”)
data = volume1.GetimageData(). ToArray()

print data

) (S |- = -

© 2010, ARR
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Python Console

ann

X| 3D Slicer Version 3.6 RC3
File Edit Wiew Window Help Feedback

falala) [X| Python Console v1.4

E‘Il.rmnn 0nni JT?.)' ;'@
‘Load orimport a MRML scene, or
add data
l 330..., 023
[211...,013]
[l 01 3]]
“H oo, 000
- [ooo0...,000]
A [131...,222]
11 L 121]
[67 3 o # S
[GitEs . 2 34]]
afl (noo ., 000] '
4 (000 ..., 000
121 R R (1 1] (] ]
it 1o Slicer dlsplays the values of the
[040 , 01 3]
B o @) R
e B
Dimensionality?—_T Spgr dataset
Detault Apply

“* Manipulate Slice Views

EEDLNEE

* Manipulate 30 View

=]

File
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HelloPython.py

@2 HelloPythonpy (~/Deskton/HelloPython) - gedit - X

File Edit View Search Tools Documents Help

0 &. 2% ¢ & 4 =

New Open Save ! Print.. ' Undo Redo ' Cut Copy Paste ' Find Replace

[7] HelloPython.py %l

#!/usr/bin/env python B
XML = “""<?xml version="1.0" encoding="utf-8"?>

<executable»

<category=Demonstration </category=

<title=Python HelloPython</title>

<description> Slicer developer course in Python
</description=

<version=1.8</version=

<license></license>
<contributor> This module was developed by Senia Pujol, Ph.D., Harvard University. </contributor>
<documentation-url> http://www.slicer.org/sliceriiki/index.php/Slicer3.6:Training </documentation-url>
<acknowledgements>
This work is part of the National Alliance for Medical Image Computing (NA-MIC), funded by the National
Institutes of Health through the NIH Roadmap for Medical Research, Grant U54 EBOG5149. </acknowledgements>

<parameters=
<label=Input/Output</label>
<description>=Input/output parameters</description=

In a text editor open the file HelloPython.py
located in the directory HelloPython

<ldUELl=0uLlpul voLldies/ taucL~
<channel>output</channel=
<index>1</index>
<description=output volume</description>
</1mage=
</parameters>

Ln 72, Col 15 INS

© 2010, ARR
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HelloPython.py

@ MM + HelloPython. py
_ﬂ! usr bindemy, puthon

THML = "nve?uml wersion="1.8" encoding="utf-g"7>
| texecutable>
i |
<categoryDemonstration </categorys |

<titlePython Hel lDPgthOl’l<f’titlE>
| <deseription> Slicer developer course in Python
| </description>

<wersionyl.8< varsions

. . <licenser</ | icenser
| {eontributor? This module was developed by Sonia Pujol, Ph.D., Harward University. </conteibutors
| <documentation—urly http:/fwew.slicer.org/slicerlikifindex.php/Slicer3.6iTraining </documentation—url>
+ <acknowledgements> i

This work is part of the MHational Alliance for Medical Image Computing {(MA-MIC}, funded by the Mational Institutes of
Health through the MIH Roadmop for Medical Research, Gront US4 EBBES149. <facknowledgementsy

<parametersk

<labels Input/Outputs/label >

<description? lnput foutput parameters</descriptions

<image’ |
<name >he | LoPython | nputio lume < Aame |
{label>Input Yolume</label>
<ehannal 3 inputd fohanne Ly
<index 3@ </ indess
<description>input volumed/description

</image> |

<image>
<name *he | LoPy thonOu tputYo Lume < /name >
<label>output Volume</label>
<channel *output < /channe L >

Cindexst {findexy
<descriptionroutput volume</descriptions

</image’
arameters
cparameters:
<lobel*Hel lo Python Parameters</label >
<descriptionyParameters of the Python Hello Python module </description:
<integer:
<riame>dimensiona L ity hame:
<longflagrdimensional ity lonaflagy
{description:Dimensionality of the Laplace operator</description:
{label>0imensional i tydlabels>
<defaul t>3</defaulty |
<constraintss |
<mimimum>2<mi ni mums
<mas i mum 3 /mas i mum
<feonstraints:
</integery
</parameters>

{fexacutable>

def, Execute {1

o T Slicer = _import__{"Slicer")
slicer = Slicer.slicer
u l lC IOI l sceme = slicer.MRMLScens

return

© 2010, ARR
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Module Description

= </7Xml version="1.0" encoding="utli-o" />

Eexecutable>

<title>Python HelloPython</title>

<description> Slicer developer course in Python </description>
<version>1.0</version>
<license></license>

<contributor> This module was developed by Sonia Pujol, Ph.D., Harvard University. </contributor>
<documentation-url> http://www.slicer.org/slicerWiki/index.php/Slicer3.6:Training </documentation-url>

<acknowledgements>
This work is part of the National Alliance for Medical Image Computing (NA-MIC),
funded by the National Institutes of Health through the NIH Roadmap for Medical Research,
Grant U54 EB005149.

</acknowledgements>

© 2010, ARR
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Module Parameters

<parameters> I
<label>Input/Output</label> ‘

<description>Input/output parameters</description>

<name>HelloPythonInpui/2''ime</name>

<label>Input Volume</label> A file that
InpUt <channel>input</channel> SpeCiﬁeS

<index>0</index>

VOIUme <description>input volume</description> the image

</image>

<image>
<name>HelloPythonOutputVolume</name>
<label>Output Volume</label>
<channel>output</channel>

OUtpUt <index>1</index>
VOI ume <description>output volume</description>
</image>
</parameters>

© 2010, ARR
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Execute Function

def Execute ():
Slicer = import__ ("Slicer")
slicer = Slicer.slicer

scene = slicer MRMLScene

return

© 2010, ARR


http://na-mic.org/

" Integrating HelloPython to Slicer3

N Yale I\ 3N Slicer Version 3.6 RC3

:lﬂ» dow Help Feedback L u u n n
... . ___Click on the View->» Application Settings

Application Settings Fz

B =i In the main menu

Help & Acknowledgement

File

-

“* Python HelloPython

Parameter set

Status Completed with errors

-

Inputoutput

Input Vaolume

output Volume

* Hello Python Parameters

Dimensionality |3 4

Detault Apply

“ Manipulate Slice Views

EEELER

* Manipulate 30 View

hp | EE
= O

Application Settings
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" |Integrating HelloPython to Slicer3

X| 3D Slicer Version 3.6 RC3
File Edit View Window Help Feedback

Y irwaowene Oelect Module Settings from
- | the Application Settings GUI

T Help & Acknowledgement

“* Python HelloPython

Parameter set = =
Ban [\| Application Settings
Status Completed with errors |—Interface Settings : Module Settings X
" -
Input/Qutput [—Drag & Drop Setlings Load Modules
o < ||| |—Toolbar Settings
nputVolume = |—Print Settings Select Modules...
= |— Slicer Settings Load Gommand-Line Plugins
output Volume .
> ||| |[—Font Settings Home Module:
n |—Module Settings
Hello Pythan Parameters |—Remote Data Handiing Settings Extensians Install Path: [(vUsersistuarwallace/Slicer3stuarwallace
Dimensionality |3 ¥ ||| |-—1A-FEMesh Settings

Temporary Directary: ((D/UsersistuartwallacesSlicer3stuariwallace

Default Apply - Directory -
| iUsersistuartwallace/DesktopiHelloPython rene -
al
7
= |
)| s
& Click on the "Add a preset” button to add one or more new user
module paths. Atypical Module path ends with lib/Slicer3iModules,
* Manipulate Slice Views whereas a Plugins/CLP path ends with lib/3licer3/Plugins.
User defined colar file paths:
&)
“ Manipulate 30 View
(@

O

[
=] (=] ]

Application Settings
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= Integrating HelloPython to Slicer3

oo~ Click on the Add a preset button, and
s [ m——

- enter the path to the HelloPython.py file

T Help & Acknowledgement

=]

“* Python HelloPython

Parameter set = >
= Ban I\ Application Settings
Status Completed with errors

|—Interface Settings + [ Module Settings x
- 5
Input/Qutput [—Drag & Drop Setlings Load Modules
o T — — Toolbar Settings
npYtxollme = |—Print Settings Select Modules...
= |— Slicer Settings Load Gommand-Line Plugins
output Valume z
-l —Font Settings Home Module:
= —Module Settings
Hello Python Parameters |—Remote Data Handiing Settings Extensions Install Path: [dusersistuartwallacerslicerastuartwallace
Dimensionality |3 » '—1A-FEMesh Settings

Temporary Directory:

Apply | | Directary
| fUsers/stuartwallace/Desktop/HelloPython

[:I.iUsers.istuanwzllzcefsllcsrﬁstuanwz\Izct
Default

s

~

LUl
k on the "Add a preset” button to edd one or more new user
|

module paths. Atypical Module path ends with lib/Slicer3iModules,
whereas a Plugins/CLP path ends with lib/3licer3/Plugins.

* Manipulate Slice Views

|

“ Manipulate 30 View

User defined colar file paths:

=

O

Application Settings
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£ -+ |ntegrating HelloPython to Slicer3

A MO

\| Application Settings

— Interface Settings

—ertece S s 1 N€ path to the HelloPython.py

— Toolbar Settings

| print Settings executable i |s now set-up in Slicer3
— Slicer Settings ¥ LOEd wOMmanda-Line Fiugins

— Font Settings

— Module Settings
I — Remote Data EIandlinQ Settings Bxtensions Install Path: [CAiusersistuartwallaceiSlicer3stuartwallac:
'— 1A-FEMesh Settings

Home Module:

Temparary Directory: [ MUsersistuartwallaceSlicer3stuartwallace
" ooy &

fUsersfstuartwallace/Desktop/HelloPython

|

~ .~
*Click on Close to exit the
Appllcatlon Settlngs window

IIIIIIIIIIIIIIIIIIIIIII

—

Close
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= |ntegrating HelloPython to Slicer3

e ————— Select File-> Exit and re- =-=~

g - - mo=astart Slicer

:9 iDSlicer

- alcome & Aboul

3pslicer Welcome

3D Slicerizafres opan source softwa e platiorm for medical image processing and 30
visualization of imags dats. This moduls contgins some bazic information and usaful links
o get you stared using Slicer. Pleass sea our website hiipofasa.2licer.org and the
documentafion on our wiki for more information:

hfiocifeeares.zlicar.orafzlicerikifinds:. oh of Docu mentation-2.6.

3D Slicer iz disribued undsr a BED-etyls licanzs; for details about the contribution and
software licenzs agreament, plegss aee
htipeffntaen.2licar.orgfcgi-binfLicansad Slicarl icanzaForm.pl. The zoftears ha: bean designed
for reesarch purpoess only and has nol bean reviewesd or approved by the Food and Drug
Adminiziration. or by anv cther agency.

Hint: 1o opsn any information pansl below, click on it grey ille bar.

Don' ehowe thiz modula on sarup.

“ Manipulatk Slice Wisws

E W CLER

“* Manipulak 30 View

Maone RAS: (87.3, 1.0, -125.0),
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HelloPython module

Fila Edit Wiew Windo

= @ [o[o-[- BoNERENENEEEEE ~ O

“4! iDSlicer
“ Welcoma & About ‘

" Select the category Demonstration, and
. e i€ module Python HelloPython in the

vigualization of image data.
10 gl you stared using Slice

documentation on our wiki fc

htiocifeeeees slicar.oralslicariy’ O l I e S | I Iel I l l

3D Slicer is disribuied |

softwa ra licanzs agresament, prooes cos g || = || LLge [ L= || Lk || =

htipeteewe.2licar.orgfcqi-bindL icenzadSlicarLicenzaForm.pl. The softears has bean designad
for neesarch purpoess only and has nol bsen reviswssd or approved by the Food and Orug

Adminizsiration. or by anv oiher agancy.

vl

Hint: 3 open any information pansl below, click on it grey fils bar.

. u} a L}
Don showe 1his moduleon sarup.
A Manipulak Slice Views
A
“ Manipulak 30 View
Pos T=q| =
ot = [
Lo

Mone RAS: (27.3, 1.0, -125.0),
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©

HelloPython Module

[a¥ala) x| 3D Slicer Version 3.6 RC3

File Edit
& &
@ 30Slicer

View

JOIEE [ () (2] (2] (@)

= @& [5][]

& § - [of

¥ Help & Acknowledgement ‘ ‘

o The program ‘HelloPython' is

Status Completed with errors

o now integrated into Slicer3

autput Volume — | ‘
-

“ Python HelloPythan

* Hello Python Parameters

Dimensionality |3 ¥

Default Apply

* Manipulate Slice Views

OEEE

* Manipulate 30 View

spgr RAS: (1316, 2.8, 186.3), Bg: Slice notshown,
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3DSlicer

Part B:
Implementing the
Laplace® Operator

*named after Pierre-Simon, Marquis de Laplace (1749-1827)

Programming into Slicer3. Sonia Pujol, Ph.D., Harvard Medical School
National Alliance for Medical Image Computing © 2010, ARR
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(I 3pslicer

Execute Function

def Execute |(HeIIoPythonInputVqume, HelloPythonOutputVolume): ‘

Add the I/O code

Slicer = __import__ ("Slicer")
slicer = Slicer.slicer
scene = slicer MRMLScene

inputVolume = scene.GetNodeBylD(HelloPythonlnputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)

return

© 2010, ARR
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Laplace Operator

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume):

Add the Laplace
Slicer = __import__("Slicer") operator

slicer = Slicer.slicer

scene = slicer. MRMLScene

inputVolume = scene.GetNodeBylID(HelloPythoninputVolume)
_outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)

laplacian = slicer.vtklmageLaplacian()

laplacian.Setlnput(inputVolume.GetimageData()

return

© 2010, ARR
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Laplace Operator

<parameters>
<label>Input/Output</label>
<description>Input/output parameters</description>
<image>

<name>HelloPythonlnputVolume</name> Add d New parameter
<label>Input Volume</label> group for the Laplace

<channel>input</channel>
<index>0</index> operator
<description>input volume</description>
</image>
<image>
<name>HelloPythonOutputVolume</name>
<label>Output Volume</label>
<channel>output</channel>
<index>1</index>
<description>output volume</description>
</image>
</parameters>
<parameters>
<label>Hello Python Parameters</label>
<description> Parameters of the Python Hello Python module </description>
</parameters>

© 2010, ARR
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& Laplace Operator

<parameters>
<label>Hello Python Parameters</label>
<description>Parameters of the Python Helle Pythan madula «/daccrintinn>

Add the Laplace

<integer> |
<name>dimensionality</name> operator's
<longflag>dimensionality</longflag> dimensionality

<description>Dimensionality of the Laplace operator</description>
<label>Dimensionality</label>
<default>3</default>
<constraints>
<minimum>2</minimum>
<maximum=>3</maximum>
</constraints>
</integer>
</parameters>

© 2010, ARR
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(J®2 3pslicer

Laplace Operator

I.d.eLExemL&ﬂ:LeLLoErthonlnputVolume, HelloPythonOutputVolume,
Ldimensionality=3}: Set-up the corresponding

Slicer = __import__ ("Slicer")
slicer = Slicer.slicer

scene = slicer. MRMLScene
inputVolume = scene.GetNodeByID(HelloPythonlnputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtklmagelLaplacian()

laplacian .Qp’rlnpu’r(inpu’r\/nlnmn (?.n’rlmngnn ta()

dimensionality parameter
In the Python code

laplacian.SetDimensionality(dimensionality)

return
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Laplace Operator

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume,
dimensionality=3):

Slicer = __import__ ("Slicer")
slicer = Slicer.slicer
scene = slicer. MRMLScene
inputVolume = scene.GetNodeBylID(HelloPythonIinputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtklmagelLaplacian()
laplacian.Setlnput(inputVolume.GetlmageData()
—laplacian SetDimensionality(dimensionality)
laplacian.Update()
outputVolume.SetAndObservelmageData(laplacian.GetOutput
return

Add code to get the output
of the Laplace operator

L)
)
p
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B Laplace Operator

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume,
dimensionality=3):
Slicer = __import__ ("Slicer")
slicer = Slicer.slicer
scene = slicer. MRMLScene
inputVolume = scene.GetNodeBylID(HelloPythoninputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtklmagelLaplacian()
laplacian.Setlnput(inputVolume.GetlmageData())
laplacian.SetDimensionality(dimensionality)
laplacian.Update()
outputVolume.SetAndObservelmageData(laplacian.GetOutput())
matrix = slicer.vtkMatrix4x4()
inputVolume.GetlJKToRASMatrix(matrix)
outputVolume.SetlJKToRASMatrix(matrix)
return

Place back the Laplacian
of the image in the RAS
reference system.
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2 Integrating HelloPython to Slicer3

def Execute (HelloPythonlnputVolume, HelloPythonOutputVolume,
dimensionality=3):
Slicer = __import__ ("Slicer")
slicer = Slicer.slicer
scene = slicer. MRMLScene
inputVolume = scene.GetNodeByID(HelloPythonInputVolume)
outputVolume = scene.GetNodeByID(HelloPythonOutputVolume)
laplacian = slicer.vtkimageLaplacian()
laplacian.Setlnput(inputVolume.GetlmageData())
laplacian.SetDimensionality(dimensionality)
laplacian.Update()
outputVolume.SetAndObservelmageData(laplacian.GetOutput())
matrix = slicer.vtkMatrix4x4()
inputVolume.GetlJKToRASMatrix(matrix)
outputVolume.SetlUKToRASMatrix(matrix)
return

Save the HelloPython.py file and exit Slicer.
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Part C:
Image Sharpening with
the Laplace Operator

© 2010, ARR
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3DSlicer

Running the Laplace Operator

'Re-start Slicer and select

Nodiss: | FrmMekeyten

B : File>Add Volume

¥ Help & Acknowledgement

mAAA

“ Python HelloPython

Parameter set

Status Completed with errors

* InputDutput

Input Volume =
-
output Volume =
-
“ Hello Python Parameters
Cimensionality (3 M
Default Apply

* Manipulate Slice Views

i L

* Manipulate 30 View

spgr RAS: (131.6, 2.8, 186.3), Bg: Slice notshown,
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3DSlicer

Running the Laplace Operator
Load the dataset spgr.nhdr

Modos: | Py Hokfpthn [R—— @
‘

B s » located in the directory

=4 n— .

\
e 25w mmHelloPython/

“ Python HelloPython J o) sw 'S HelloPython
) sw2 HelloPython.pyc FKB SunJun 619: [

) swb4 0 Py TR 3KB SunJun B11: |\] T
) System spgr.nhdr 1 KB SunJun 610

= tmp SpOr.raw.gz 6517 KB Sun Jun 610: E
* Inputoutput | ) User Guides And Information
B 3 Users
=) Shared
B [ stuartwallace
=) .autobahn
{ ) .Cups
* Hello Python Parameters J .fontconfig
subversion
Trash
) -Xcode
B |5 Desktop
1 ) 3Minute Ford.6
) ChangeTrackerStuff-3.6 o
“\ Hello Pvthon i
< — = | ] 5 || e —

Path: |Uszersistuarwallace/Desktop/HelloPythonispgr.nhdr

Dim

/oooo

Default

£
|
P

Volume Options

Centered Ignore File Orientation Label Map 3ingle File MName: |spgr

|
Recent Volumes

* Manipulate Slice Views Browse to CWD

LBk

“ Manipulate 30 View

Apply| | Cance'
P

Add Volume
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£~ Running the Laplace Operator

(aVala) '\| 3D Slicer Version 3.6 RC3

File Edit Vview Windg Galo  Feedback

(D= @ B ] (&) @) (@) & [ (@] 2] = ]| 0] B & F -

- Browse to the Category

¥ Help & Acknowledgement

Demonstration in the Modules

Parameter set =

e menu, and select the module

Inputioutput parameters al
v

-« Python Hello Python

Default Appl qr
peY = st = Hene coma 2 wene z
C e - spart Heno e spart -

Pt
129 |-27.932

-
9] 128 [13.769

* Manipulate Slice Yiews

EEODEEEERRE B

“ Manipulate 30 View

| EEEE®
L

i L

O EEEE

spar RAS: (128.1,12.8, 37.2), Ba LIK: (128, 138, 148), Bg: Qut of Frame,
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Running the Laplace Operator

.lel e | 3D Slicer Version 3.6 RC3
File Edit Wiew Window Help Feedback

(& ]| e | e | [] o] (5] @ o= ][] (6] () R ) [ () 0 D O [ - - O

B e N /]
s Select the Input Volume spgr,
: select the Output Volume

e Create New Volume, and click

outputvolume | o

* InputQutput

“ Hello Python Parametars

: Apply
Dimersionaity [ / J N
Cefault Apply - I
] Sl
HNena =1
=

4 st =l Heno - Senn ;‘v Hens
: = ] . B
[Sl[=] o [ [9lf]]

(g =
129 |-27.532

* Manipulate Slice Views

EEENEEEEE B

* Manipulats 30 View

- | EEEE®
1t R EE R A ]
L EElE

spar RAS: (0.9, 183.3, 97.5), Bg LIK: (-53, -8, 1), Bg: Out of Frame,
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~Running the Laplace Operator

Slicer displays the Laplacian of the spgr image

@ 30Slicer

¥ Help & Acknowledoement

* Python HelloPython

Parameterset| o l:j

Status Completed

InputVolume | g ’:j
OutputWolume | g ¢ — ’:j

“ Input/output

“ Hello Python Parameters
‘ Dimensionality |3 ﬂ|
Default | Cancel | Apply e . |‘| @ one . |‘
e v -
) Culput okme — "% I | Cutput velms =1 H%
129 |27.532 - : 128 13763

“* Manipulate Slice Views
EEONEEEEEE ']

“* Manipulate 30 View

| EEE

@
5]

Output Volume RAS: (0.5, 138.8, 53.8), Bg 1JK: (-7, 9, B1), Bg: Out of Frame,
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3DSlicer

Laplacian of the image

[\ 3D Slicer Version 3.6

a6an

% Window Help Feedback

& §-

EFEE €

B[] e [orenemn =] [ DI - B8 ] [ 6D O]
@35’5" ' -
Select the module Volumes from the main menu

¥ Help & Acknowl
—_—
* Python HelloPy.

Parameterset) l:j

Status Completed

Inputvolume | gr ’:j
QutputVolume | o g ’:j

“ Hello Python Parameters
‘ Dimensionality |3 j|
Hena = |

e

“ InputCutput

Sagittal | + 1
:
|

Default | Cancel | Apply " _‘|‘
> e v [
. A e |2 o ]
] : : . 128 |13.763

[T 2 [ersm [9[]=]

“* Manipulate Slice Views
EEDNEEEEE R =]

“* Manipulate 30 View

- EEEE-®
-t GguEE s 0
U e

Output Volume RAS: (0.5, 139.6, 83.8), Bg 1JK: (-7, 9, B1), Ba: Out of Frame,

9y,
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3DSlicer

Laplacian of the image

:Set the Active Volume to Output Volume and adjust
‘the Window/Level parameters

Active vVillime: Cutput Volume

* Display

Lackup Table: Grey =

Interpolate

Wincawy Level Editor Presets:

Threshold:

— e
[ Undate Histogram Interactively autal Hore — [ Hoe — = cotaal Hoe = i
[-875, 854] x [0, 1] (. Howe Orptionme == Orpationme = [ Howe o rptioime =
S~ +] & )|~
| 129 |-27532 23 I 128 13768

* Manipulate Slice Yiews

E@EELE

“ Manipulate 30 Yiew
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& e Image Sharpening

Run the following code in the Python -
console to subtract the Laplacian of the
Image to the original image —

\\\\\\\
Laokup Table: Grey e
mmmmmmmmm
Wincnwy Lesel Fditor Presets

import Slicer

volume1 = Slicer.slicer MRMLScene.GetNodeByID(“vtkMRMLScalarVolumeNode1”)
volume?2 = Slicer.slicer. MRMLScene.GetNodeByID(“vtkMRMLScalarVolumeNode2”)
plugin = Slicer.Plugin(“Subtract Images”)

plugin.Execute(volume1,volume2)

= = — = oy 2T e S 7 N - \
“* Manipulate Slice Yiews ('}I{f'\\;"&‘ ‘J ‘W ;J()'-\‘I,;\\'\ :"-')' t“,"" /. .\\
— { ok { g ] A
EEDDEEEE SErm— e s ;; i1 Sl
“ Manipulste 3D View I': [ B ; f:—'-:_\ & ' - . ‘ . .N_ 2 r’
Elp(a= L e fennal
| [ @
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Image Sharpening

3D Slicer Yersion 3.6.1 =]
=

File Edit Wew Window Help Feedback

Bl [&] e e AEEHETffI@
Select the module Data

¥ Help & Acknowledgement

The subtracted image

Scene J

vtkMRMLScalarVolumeNodeA

spar
Output Yolume

i, 4 appears in the data tree

|

X

Dizplay MRML ID's

MRML Made Inspector -
* Load & Add Scenes Or Individusl Datasets ey T :4 = = A
B sl e == noe — Cornal == Nowe ==
Load new scene (close current) Hone Srpticime = arprtoime = |5 None = Svpaticime =
&dd & =cene (to current) @D |\"” ~ |
\ 128 [13763

120 [-27532
A data or & data dirsctary - = .

’ﬁ‘ E‘ Aoddd scalar and tensor volumes: ﬂ

“ Manipulste Slice Yiews

BB

“ Manipulste 30 View
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B o Image Sharpening

2 3D Slicer Yersion 3.6.1
File Edit WYiew Window Help Feedback

Wos: b — [+][=] —
.
N

{;\ 3DSlicer
=
Click on the links|(®| and on the eye >

|»

“* Display & Modity Scene

DE © || icons and select the

Wig

o vtkMRMLScalarVolumeNodeA in the

vtk MRMLS calaryolumeM oded

background layer to display the
= || subtracted image in the viewer

Display MRML ID's
MRML Mode Inspector -
- L
“* Load & Add Scenes Or Individual Datassts & S [ - ‘
E;‘Y, Al =s [ == H;t sagttal — : How == E;‘Y, Coroal == [ =
Load new scene (close current) Howe = AMRMLSEAROIe ok s, —) | Howe =: IRMLSCak e ks | Howe =s (] | #mrmLcatariaime Hode s, —1 =
Addascene(tocurrent) CD|\"H' | cD“””": | @|VH' |
[ 120 [2rss | 63 [23 [ 128 13769

Add dats or 5 data directory
’E‘ ’E Add gcalar and tenzor volumes Li
* Manipulste Slice Yiews

EEANBEEEE G @]

* Manipulste 30 View

ks EEE L] &
gl (]
L EERE
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Image Sharpening

-
)
9]
%2}
[
™M

Laplacian filtered

Laplacian

Igina

Or
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~3DSlicer

Conclusion

* This course demonstrates how to integrate an external
program in Python within Slicer3

* The Execution Model of Slicer3 provides a simple
mechanism for incorporating command line programs as
Slicer modules in Python.
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